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We Need Your Vote!
Voting in the 2012 Shares magazine awards has begun and we would be 
delighted to receive your vote in the “Best Investment Software” category. 
Thanks to your support we’ve won this award for TEN years running. This 
year Shares has also included a “Best Customer Service” award. We put a 
huge amount of effort in trying to offer exceptional customer service so 
if you think we deserve it we would be extremely grateful to receive your 
nomination in this category too. 

To vote, please click here. By voting you’ll be entered into a prize draw to win an iPad.

Alpesh Patel

View From The Top
It’s a tough call this month - 50/50 if higher or lower. I am going to go for lower. 
The momentum indicators are finely balanced. I am taking my cue from the weekly 
Stochastic as an accurate indicator. A quiet month can lead to sharp moves in either 
direction so no guide there. Valuations are low but that does not mean the market 
rises. Finally there is the broader political situation - again as much likely positive 
relief as negative.

I think most people would be happy with an 8-10% return from equities this year. Corporate profits have 
been strong but low interest rates lead to reduced expectations. Personally I expect more given valuations 
and cash flows.

There has been a lot of comment about Japan 
in the last few months. I’ve not liked Japan for 
a while. Okay it should benefit from being an 
advanced economy neighbouring a giant like 
China - and between China and Japan you have 
the second and third largest economies in the 
world - but it keeps failing and faltering. The 
Nikkei in the short term is moving in waves 
and this wave could go to 10,000.

If I had to choose one BRIC to invest in, it 
would be China even though there is lots 
about it I don’t like politically. Not Russia 
as I don’t trust their Government.  India’s 
corruption and government has stalled them 
- but the weak Rupee will help.  And Brazil is a 
close second to China but smaller, so I’ll play safer with China which manages its economy better.
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Phil’s Hidden Gems

Phil Tolhurst

View news stories for your portfolio
You can also filter the news feed for stories related to the holdings in a portfolio. If 
you are a ShareScope Gold user, press the Backslash (\) key whilst in the Portfolio 
view to display the News view. By default, news for the share currently selected in 
the portfolio will be displayed. Right-click in the News view and select Parent list from the menu. The News 
view will now contain stories for any holding in the portfolio.

ShareScope Plus/Pro users: you may prefer to have a linked window showing the news for your portfolio. 
Create a new News window and link it to the Portfolio window. By default, news for the share currently 
selected in the Portfolio will be displayed. Right-click in the News view and select Parent list from the menu. 
The News window will now contain stories for any holding in the portfolio.

View a calendar of events for your portfolio
The Calendar is a diary of company events for the instruments in a list. It’s a great tool when used with a 
portfolio. Look at the screen shot below: you can see that you can select the time frame and the types of 
events displayed. You might look at the Calendar at the weekend to get 
the heads up on events affecting your holdings over the coming week.  
Or you might use it to check the events that will occur whilst you are 
away on holiday.
 
You will find Calendar on the View menu. It will display events for all 
the instruments in the currently active list. Plus/Pro users, make sure 
the required window is active before open the Calendar. The Calendar 
is not a permanent view – it is displayed in a dialog – but you can print 
or export the information if required.

Password-protect your copy of ShareScope
You can make sure that no-one else uses your copy of ShareScope by setting a password. Once set, 
ShareScope will ask for this password each time you start the program. 

Note: this is NOT the same as the Comms password you receive with your 
account number. This password is entered only once when you install (or 
re-install) the program. 

On the Tools menu, select Program password. The following dialog will 
appear (Fig. 1):

Click on Program password on and then type a password into the New 
password and Confirm password fields. There are no rules imposed.  
Click on OK when done. If you subsequently want to disable this 
feature or change your password then you will first need to type in your 
password in the Current password field at the top.

The next time you start ShareScope, you will be prompted to enter your 
password (Fig. 2).

Note: We have no way of knowing your password so please write it down 
and keep it safe. If you do forget it, please call us; we have a way of 
disabling the password feature. 
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Rename your Settings
Hopefully, you’ll be familiar with the concept of Settings in ShareScope. That is, in each view you can 
configure up to 12 different Settings (templates). For example, in the List view you can set up 12 different 
tables. You may have a simplified table which you use as a heatmap and different tables for shares, 
unit trusts and investment trusts. If you are not familiar with this concept, I urge you to read Chapter 6 
– Settings of our online manual (www.sharescope.co.uk/userguide).

To help you remember which table is which you can give each one a more descriptive name. To do this, we’ll 
need to use the Settings menu. This will always be the sixth menu option on the ShareScope menu bar. 
Its name varies depending on which view you are in. For example, if you are in List view then the menu is 
called List Tables; if you are in the Graph view, it is called Graph Settings. Click on this menu and select the 
Setting that you wish to rename. Then click on the Settings menu again and select Rename Setting. You will 
be prompted to enter a name.

You should also be familiar with the Settings toolbar running along the bottom of the ShareScope window. 

By default, this includes buttons for the first four Settings. They change depending on which view is 
currently active. You may have added more Settings buttons to the toolbar. You will notice that when you 
change the name of a Setting that the name on the corresponding button will automatically be changed as 
well. 

Candlestick pattern recognition – trend options
ShareScope Plus & Pro can automatically detect 16 bullish and 16 bearish candlestick patterns. These can 
be highlighted with flags on your charts. To find this feature, right-click in the Graph view, select Other main 
graph features and then Candlestick patterns. You can also data mine for these patterns: for example, find 
all charts exhibiting a bullish candlestick pattern in the last two days. 

Classical thinking is that candlestick patterns are of most use 
when they occur in an established trend. That is, bullish patterns 
occur in a downtrend thus predicting a reversal and vice versa. By 
default, ShareScope only displays candlestick patterns where an 
established trend is present. You can relax or disable this feature.
To determine the trend, ShareScope first calculates the trend 
over short (5 day) and long (20 day) periods. Because the short 
trend is very volatile, ShareScope also checks the short trend 
for the previous day’s candlestick. Only when the direction of all 
three trends are aligned up or down will ShareScope check the 
candlestick pattern.

In the Candlestick patterns dialog box, there are three options relating to this feature. The default setting 
described above is Standard. The Relaxed setting only checks the short trend and the previous day’s short 
trend. The None option performs no trend checking.

Intraday graph – days displayed
When you select the number of days viewed on an Intraday graph (in Graph design), you can choose from a 
drop-down menu with a range of options from 1 to 120. 
However, you can also type in a different number (e.g. 21 
for a trading month). Instead of clicking on the down arrow 
to reveal the drop-down menu, highlight the first option (1) 
and type in the required number:

The same is true when setting the number of standard 
deviations for Bollinger bands.
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GM’s Column

Tim Clarke

Making the best use of your screen space
There are a number of features in ShareScope which can help you maximise the use of 
your screen space. If you have a small monitor size and/or low resolution then these 
features can make a huge difference to the amount of data you can see.

Toolbars

Perhaps the first place to start is your Toolbars. By default, you have three toolbars: the Main toolbar across 
the top of the screen (underneath the Menu bar); the Graph toolbar running down the right-hand side of 
the ShareScope window; and the Settings toolbar running along the bottom of the window. Subscribers to 
the Alpesh Patel Special Edition will have a fourth toolbar on top of the Settings toolbar.

The first decision to make is: do you use all these toolbars? The investors amongst you may never use the 
Graph toolbar for example.

The second decision is: could you consolidate all the buttons you use onto just one or two toolbars?

For the suggestions below, you’ll need to become familiar with the Customise toolbars dialog. You can 
access this in two ways: from the Tools menu or by right-clicking in the toolbar that you want to edit.

I am not going to give you detailed instructions here due to limited space but I recommend you read 
Tutorial 21 – Customising Toolbars in our Training Zone (www.sharescope.co.uk/trainingzone). 

I would suggest you start by making sure that your 
toolbars take up as little space as possible. There 
are three sizes of toolbar button: Small, Large and 
Extra large. You’ll find the button size options on 
the Settings tab of the Customise toolbars dialog. 
You’ll need to find a balance between saving 
space and being able to read the buttons!

Also on this tab, you can make buttons smaller by 
choosing to display just the icon or text instead of 
both. You don’t necessarily need the text for each 
button because if you move the mouse cursor 
over the button a description will appear. 

You can change these options for individual buttons by right-clicking on a toolbar button and selecting Edit 
button.

Next you could consider if there are any buttons on your toolbars that you don’t need. An easy way to 
remove unwanted buttons from a toolbar is to right-click on the button and select Delete button (make sure 
you don’t select Delete toolbar!).

Once you have got your toolbars as compact as possible, you can see whether you might be able to 
consolidate two toolbars into one. As an example let’s suppose you could fit all the buttons you use on the 
Settings toolbar onto your Main toolbar.

First, you need to add the required buttons to the Main toolbar. Right-click on the Main toolbar and select 
Customise toolbars.  The Buttons tab is where you can add buttons to or remove buttons from a toolbar. 
Refer to the tutorial mentioned earlier for detailed instructions. If they fit then you can remove the 
redundant toolbar. Right-click on the toolbar and select Delete toolbar.
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Show title bar Hide title bar

Hide window title bar

This feature is for ShareScope Plus and Pro users only as it relates to multi-window layouts. You can remove 
the title bar from individual windows to create more usable space. To remove the title bar from a window, 
right click on the title bar to display the context menu. You should see the Show title bar option which will 
have a tick next to it. Click on this option to remove the tick and hide the title bar. To reinstate the title bar, 
right click on the border of the window and follow the same steps as above. With the title bar hidden, a 
dotted line appears in the top of the window border (see image below). To move the window, click on this 
dotted line and drag.

Rich’s Scripts

Richard Chiesa

In this issue, I thought I’d highlight some of the popular scripts that we have created 
and made available in the ShareScript library.

Data Export
Data Export is a ShareScript Study designed to help you export the new on-demand 
intraday data.  The normal methods of exporting data from ShareScope and previous scripts all focus on the 
locally stored intraday database. Right-click inside an intraday graph, select Other main graph features and 
then ShareScript studies. In the dialog, click on the Script Library button. In the new dialog, select Studies 
from the drop-down menu at the top and then search for Data Export. Once loaded an Export button is 
added to the graph (see image below). 

Clicking on the button will export the price and volume data displayed on the graph. The date, time, open, 
high, low, close and volume for each bar will be saved to the C:/ShareScope/ShareScript/Output/ folder. 
The EPIC code of the instrument will be used for the filename.
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Total Return
This is a Column script that displays the percentage return between two dates, including dividends. It 
combines the share’s yield over the period and its percentage price change.  You could use this column for 
your portfolios or to find shares with a high total return over, say, three years. You could also use the script 
to calculate total return per calendar year. Right-click in the column headings of a table and select Add 
ShareScript column. Click on the Script Library button and search for Total Return. 

Mid Change since X mins ago 
This script is designed for use with heatmaps. The heatmap options in the List design dialog allow you to 
colour the heatmap based on the price change since x minutes ago. The default is 60 but you can change 
the value. However, there isn’t an inbuilt column which will show the price change over this period. This 
script solves this problem.

Right-click in the column headings of your heatmap and select Add ShareScript column. In the dialog, click 
on the Script Library button and search for Mid Change since X mins ago.

Note: the shorter the period you use, the smaller the price changes will be and consequently the colours  
on your heatmap will be less vivid. Using the relative colouring scheme rather than the absolute scheme  
will help.
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